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1 Introduction 
1.1 Manuals and Help 
The following sources of information help you learn Nigra, your software for the evaluation of level-
lings. 

Getting Started Guide. The book you are reading now. The Getting Started Guide contains a general 
overview, system requirements, installation instructions and first steps to use Nigra. 

Reference Manual. The reference manual is available as .PDF file to read or print with Acrobat 
Reader. The manual contains detailed technical information for all Nigra items. 

Online Help. The technical informations are also available in the online help system. Help means 
quick search and index but also context sensitive help. To get context sensitive help, press the F1 key 
from any place in Nigra, and you will see help that describes the part of Nigra that you are in. 

If you are updating from Nigra/DOS, the chapter from Nigra/DOS to Nigrawin is very important. 

1.2 Getting Product Support 
If you can't find an answer in the section Questions and Answers in the online reference or on our 
website http://www.trukksoft.de, write a email with your question to mail@trukksoft.de or send a fax to 
0049-2241-315954. We can only answer if your question is in English or German language. 

1.3 General Overview 
Nigra is a special software for the registration and evaluation of all kinds of levellings. With its addi-
tional programs Levnet/Nivnet, it covers almost the complete user spectrum for levellings. 

Nigra runs under the operating systems Windows 98/ME/NT 4.0/2000/XP and Vista. 

Nigra is an international program: The texts for all printouts are stored in separate data files and may 
be adapted by the user. Files for the languages English and German are included. Evaluations may be 
performed in meters, feet or inches. 

The core of the program is the calculation of levellings performed with digital levelling instruments 
(Leica, Trimble (Zeiss), Topcon, SOKKIA). There is also an integrated manual data registration similar 
to the traditional field book. Thus you may enter and compute the data with a notebook, directly in the 
field. 

Nigra computes different kinds of levellings: levelling with side shots, line levelling, line adjustment and 
instrument testing. 

The Nigra Height Database is able to store almost any number of points per job. There is an interface 
for the import of heights from any text files and for the export of heights in the ASCII format. 

Movement measurements may be computed automatically in list form or as movement diagrams. 

Profiles can be established either from levelling data or from tachymeter data in the Y,X,Z format. 

1.4 Installing Nigra 
Make sure that Windows 98/ME/NT 4.0/2000/XP or Vista is installed on your computer. 

Close all open applications. Insert the Nigra CD-ROM into the appropriate drive. 

Select the Run button in the Start menu. 
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Then enter the command line x:\setup.exe (where x is the letter of the CD-ROM) and click OK to start 
the installation. 

Follow the setup instructions on the screen. In case you have already installed Delta/DOS, it is 
important to select a different installation folder for Nigrawin than for Delta/DOS. This allows you to 
work simultaneously with both versions for some time and gradually change over to Nigrawin. 

After installation is completed, a new item will be added to the Start menu and to the desktop. Double-
click the Nigra icon to start Nigra. 

The Nigra template folder is installed under c:\nigra\templates. If Windows Vista is installed on your 
computer, then copy the complete folder to another place (drive, folder), where you have the full 
access. Then change in Nigra under Options, Program Configuration, Misc. the entry for the Folder for 
templates to the new place. 

Uninstalling Nigra 
To uninstall Nigra proceed as follows: 

Click on the item Settings in the Start menu, then on Control Panel. Make a double-click on the icon 
Add/Remove Programs. In the box below select the line which contains the name of the Nigra 
software and click on the button Add/Remove. In the dialog box Select Uninstall Mode select 
Automatic and click the Next button. Then follow the description in the following dialog boxes. 

All files installed by Nigra will be removed. Files which are created after installation of Nigra will not be 
deleted. Therefore the Nigra folder will not be deleted. You can remove this folder manually after the 
uninstall procedure is finished. 

1.5 Starting Nigra 
Start Nigra by clicking on the Nigra icon in the programs menu. 

1.6 Quitting Nigra 
You quit Nigra by clicking on Exit in the File menu. Alternatively, you may quit Nigra by pressing the 
keys [Ctrl]+[F4] if all Nigra windows are closed. 

1.7 From Delta/DOS to Nigrawin 
This section is intended for users who have already worked with Delta/DOS and want to transfer their 
data and files into Nigrawin. You will quickly feel at home in Nigrawin if you have previously worked 
with Delta /DOS, since the basic application structure is similar. 

Differences between Nigrawin and Delta /DOS 

Many differences between Delta /DOS and Nigrawin are based on differences between DOS and 
Windows. Windows, for example, uses a different font than DOS. Consequently, all DOS fonts with an 
ASCII value > 127 are presented differently in Windows. This also applies to the German 'umlauts', or 
vowel changes. You may transfer DOS text files into Windows format with the Nigra function Convert 
ASCII  ANSI (File menu). Unfortunately, there is a small problem: The Windows font does not 
include all DOS symbols. 

The special user administration for Delta/DOS has been given up. You may now work in any folder 
with Nigrawin. 

The job file with the measurement data ('job'.DAT) from Delta/DOS is compatible with 'job'.NIG from 
Windows. You should, however, use the ASCII  ANSI conversion once in order to make sure that 
the German 'umlauts' are correctly presented. To convert the file extension .DAT to .NIG, use the 
function Program Configuration in the Options menu. 
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The Nigra height database is not compatible. This file has a different database format and an ex-
tended data structure in Nigrawin. 

You may transfer your old heights into Nigrawin without any problem: Export the heights as an ASCII 
file in Delta/DOS and import them into Nigrawin via the ASCII interface. The table below shows the 
differences in the data structure: 

 
Data Field Nigrawin Delta/DOS 

Date 10 characters, e.g., 10-
15-1997 

8 characters, e.g., 10-
15-97 

Remarks/ 

Comments 

max. 30 characters max. 19  characters 

Y-coordinate Y-coordinate not available 

X-coordinate X-coordinate not available 

 

All remaining data fields have the same data format as in Delta/DOS. The coordinates are not com-
puted at this time, but are only recorded and stored. Thus you may import available 3D data without 
loss to Nigra and subsequently re-export them. 

The Nigrawin height database (file extension .MDB) is compatible with the Microsoft Access database. 
You can access the Nigra database with MS Access, for example, in order to create special database 
reports. In this case, you should always work with a copy and not with the original database! 

All texts for printouts, for example, headers for calculations and height database, are not an integral 
part of the program. They are located in an external file with the file extension .LAG and may be 
adapted by the user according to his own requirements. They serve mainly for the adaptation into 
various languages. 

The files ENGLISH.LAG for English texts and DEUTSCH.LAG for German texts are included. 

All calculations may be performed in meters, feet or inches, as desired. 

An editor for editing the measurement data and other ASCII files is an integral part of Nigrawin. You 
may, however, use your own editor. 

The job-specific parameters are located in the USER32.OPT in the respective job folder. 
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2 First Steps 
2.1 Setting Program Parameters 
When first starting Nigra, it is advisable to make some program customizations and alter the standard 
parameters. Select the Program Configuration item in the Options menu. The parameters are 
stored in the Windows Registry, separately for each user. 

 
Setting Program Parameters 

The individual input fields have the following functions: 

Company - Name of Company defines a header for all printouts (for example, company name and 
address). 

Header graphics allows defining a graphics to be printed in the head of a printout (calculation, 
movement list, etc.) in addition to the company name. Graphics name defines the complete file name 
of the graphics (including drive and folder). Alternatively you can double-click on the input field or click 
on the button on the right side to open a selection dialog box. 

Nigra works with the graphics formats BMP, ICO, and WMF. In the field Graphics dimension you can 
define the size of the graphic (width and height). If these values differ from the original graphic size, 
the graphic will be resized in the printout. 

Number of lines defines the area of the graphics needed in the printout. Each page of the text will be 
reduced by this number of lines. 

The graphic will be printed with right justification. If you print from the editor, the graphics will not be 
printed. 
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Interfaces: 

 
Defines the numbers of the serial Com-interfaces to which Leica GIF 10, Trimble DiNi, Topcon DL-100 
or REC 500 (for data transfer from the program Nivellieren à la carte) are to be connected if you want 
to use the Nigra-integrated data transfer. If you use a separate program for your data transfer, this 
entry is irrelevant. 

Error Limits: 

Error limits defines the boundary values according to the most used formula: (example of unit of 
measurement "meters") 

        Misclosure E (in mm) = a + b * √D (in km) 

(a = constant error part in mm, b = systematic error part in mm, D = levelling distance in km) 

 
The error limits for the four error classes can be defined in free formula style as a function of the 
levelling distance D, for example, 2 + 3*Sqr(D). "Sqr" means square root and D the levelling distance 
in km. In modification of this standard formula, you can also calculate, for example, the term 2 + 
3*Sqr(D/2). 
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When calculating manually and reformatting the digital level raw data you may choose the error class 
as required. 

If you have chosen the unit of measurement "feet" or "inches", error limits will also be entered in these 
units. 

Programs: 

Transfer programs for Digital Levels: Here an entry is only required if you do not want to use the 
integrated Nigra data transfer (for Leica GIF 10, Trimble DiNi, Topcon DL-100 and Trimble(Zeiss) Rec 
500). Enter the name of the transfer program supplied by your manufacturer, including file extensions. 

Editor name: An entry is only required if you do not want to use the text editor integrated in Nigra. In 
any case, the editor has to be a Windows program, for example, the word processor WRITE. The 
editor must be entered completely with drive and path, for example, c:\winnt\system32\write.exe. 

A click on the buttons on the right will display a dialog box for selecting a program. 

In addition to these program parameters, special parameters can be defined for each job. To do this, 
however, a particular job must be opened. How to open and start jobs is described in section 2.2. 

Miscellaneous (Misc.). 

 

Nigra Background Color: Defining the individual color for the Nigra background. 

.DAT  .NIG: Changes all file extension in the current folder from .DAT to .NIG. From Nigrawin Rev. 
2.0, .NIG is the file extension for Nigra job files with measurement data. 

Folder for Templates: With this function you choose a folder for the template files (english.lag, 
dinicode.txt etc.). The default folder created during the Nigra installation is c:\program 
files\Nigra\TEMPLATES. 

Before using this option, create the new folder and copy all files from c:\program 
files\Nigra\TEMPLATES to this folder. 

c:\program files\Nigra = Nigra installation folder 

Job folder: With this entry you can choose a folder which will be shown while opening a project. 

When all data have been entered, click OK. 
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2.2 Opening/New Job 
Nigra works job-oriented. This greatly facilitates the subsequent handling of the program, as all 
operations, for example, calculations, refer to this job, and the required parameters and data files are 
created and selected automatically. 

After starting Nigra, first create a new job or open an existing one. Choose from the File menu 
Open/New Job .... You may start a new job in any given folder by entering a job name or choosing an 
existing job (with the file extension .NIG). 

The job name will be shown, complete with the full path name, in the header of the Nigra window. 

Opening Job 

The last 6 jobs opened appear in the bottom item of the File menu. If you want to use one of these 
jobs, click on the desired item. 

2.3 Individual Configuration 
The individual configuration (in the Option menu, item Job Configuration) enables the user to adapt 
the program configuration to his special job. 

The individual configuration is valid for the job in use and all further jobs to be processed in the same 
folder. With this configuration you may, for example, define the units of measurement (meters, feet, 
inches), the country-specific file for the printouts or other preset parameters. 

If you create a job in a new folder, the last used job parameters are transferred to the new folder. 
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Defining Individual Configuration 

2.4 Levelling with Digital Levels 
If you want to calculate with levelling data obtained from a digital level and registered in a data stor-
age, the following steps have to be taken: 

• Transfer the data to the computer 

• Reformat the raw data into the special Nigra format 

• Enter the heights of the fix points.  

• Start calculation. 

Click the Leica, Trimble, Topcon or SOKKIA icon or select the item Leica, Trimble, Topcon or 
SOKKIA from the Digital-Lev menu. 

From the following submenu select first the item GIF 10 ↔ PC, NA/DNA/Sprinter Raw Data ↔ PC , 
DiNi Raw Data ↔ PC, DL-100 Raw Data  PC or SDL Raw Data  PC to transfer the raw data to 
the PC. Follow the instructions on the monitor screen. Add the file extension .NA2, .GSI or .DNA to the 
raw data file for Leica data, .DIN for Trimble data, .TOP for Topcon data and .SOK for SOKKIA format. 

Subsequently, the data transmitted to the PC are reformatted into the Nigra format with the menu item 
Format NA/DNA/Sprinter-GSI  Nigra, Format DiNi Rec E  Nigra, Format DL-100  Nigra or 
Format SDL  Nigra. A dialog box for the selection of the file name for the raw data file appears on 
the screen. 

In the following dialog box for reformatting use the Measurements option to transfer the raw in the 
Nigra measurement file. Then select or enter parameters or header data by clicking Parameters and 
Header data. 
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Reformatting Raw Data 

 

Entry of Parameters: 

 
Take your time and select the appropriate parameters carefully. A detailed description of the parame-
ters is given in technical reference. 
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Entry of Header Data 

When all entries are completed, click on OK or Exit. 

Reformatting is started by clicking Run in the dialog box for Reformatting Raw Data. The lines of 
your raw data as read by Nigra will be displayed on the screen. After reformatting, the individual 
levellings are automatically numbered with consecutive calculation numbers. 

There may still be some point numbers to be corrected or lines to be deleted. Click the editor icon to 
edit your measurement data file. Alternatively, corrections can also be made in advance in the raw 
data file. 

Enter the heights of the reference bench marks in the menu item Enter Heights in the Heights menu, 
then click the button for batch calculation. The following dialog box will appear: 

 
Starting Batch Calculation 
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Enter the first and last calculation number and start batch calculation by clicking Run. After completion 
of the calculations, click the button for edit calculations to display the calculations on the screen. 

 

You can print the calculation from the editor or close the editor and print with the print button. 
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